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Preface

Simulink, developed by The MathWorks, is a commercial tool for modeling, simulating and analyzing
dynamic systems. Its primary interface is a graphical block diagramming tool and a customizable set
of block libraries. It offers tight integration with the rest of the MATLAB environment and can either
drive MATLAB or be scripted from it. Simulink is widely used in control theory and digital signal
processing for simulation and design.

This training will give you the basic knowledge of Simulink and how you can use it together with
MATLAB.

For more information about MATLAB and Simulink, see my Blog: http://home.hit.no/~hansha



http://home.hit.no/~hansha
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1Introduction to Simulink

Simulink is an environment for simulation and model-based design for dynamic and embedded
systems. It provides an interactive graphical environment and a customizable set of block libraries
that let you design, simulate, implement, and test a variety of time-varying systems, including
communications, controls, signal processing, video processing, and image processing.

Simulink offers:

e A quick way of develop your model in contrast to text based-programming language such as
e.g., C.

e Simulink has integrated solvers. In text based-programming language such as e.g., C you
need to write your own solver.



2Start using Simulink

You start Simulink from the MATLAB IDE:

Open MATLAB and select the Simulink icon in the Toolbar:

MATLAR 7.4.0 (RZ007a)

Srxteuts (8] Hovebo b (2] Wb
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Or type “simulink” in the Command window, like this:

[Command Window w0 a x

o To gek started, select MATLAE Help or Dermos From the Help menu, x

This iz a Classroomw License for instructional use only.
Dezearch and comercial use is prohibited.
SIT: idded paths for Simulation Interface Toolkit Version 2009
Starting the 23IT S3erver on port 6011

3 Eli!lg! tarted

>

Then the following window appears (Simulink Library Browser):




3 Start using Simulink

=1 simulink Library Browser
File Edit Wiew Help

DS 4 |
Commonly Used Blocks: simulink/Commonly
Used Blocks

= Tl Simulink.
2] Commonly Used Blocks
- Continuous

. # Discontinuities " Continuous
. B Discrete Rl e
- 2] Logic and Bit Operations Dizcontinuities
-2 Lookup Tables &
; y IMath Operations E'\_ Discrete
. 2] Model Verification &3]
" 2 Model-wide Utilities = ; ; ;
= &If 5= Logic and Bit Operations
- B Ports & Subsystems ml =
o #] Signal Attributes
& fﬂ signal Routing L y=fiud | Lookup Tables
E g &2}
-2 sinks +
-3 Sources L o | MathDperations
o
2 User-Defined Functions li‘
¥ 24| Additional Math & Discrate @ Maodel ¥ enfication
- @ Control System Toolbox [+ @
Bl Data cquisition Toobox wise | Modebwide Litiites
[ ﬂ Fuzzy Logic Toolbox =

- W Model Predictive Contral Toolbos n B RS,
T orts & Subspstemns

- 8 NLSIT Blocks G el
e El MNeural Metwork Toolbox 2
g B Real-Time Workshop . = Signal Attributes
- B simulink Control Design &
% W] Smuink Extras Fig| sinsiRouing
& ﬂl Simulink. Response Optimization (&3]

Subs

- Stateflow ae] Cirks
- B System Identification Toolhox o] e
- B Virtual Reality Toolb
- BB Virtual Reslity Toolbox s

|

User-Defined Functions

| % )

&

addtonal Bt s dditional Math & Discrete
L

Ready

The Simulink Library Browser is the library where you find all the blocks you may use in Simulink.
Simulink software includes an extensive library of functions commonly used in modeling a system.
These include:

e Continuous and discrete dynamics blocks, such as Integration, Transfer functions, Transport
Delay, etc.

e  Math blocks, such as Sum, Product, Add, etc

e Sources, such as Ramp, Random Generator, Step, etc

2.1 Block Libraries

Here are some common used Continuous Blocks:
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Start using Simulink

Imtegrator

| =

# = At Bu

¥ = Gt Du State-Space

— Tranzfer Fon
=+1

E%Z Tranzport Delay

Here are some common used Math Operations Blocks:

* Add
N
> Gain
ot Product

@ Sum

Here are some common used Signal Routing Blocks:

Here are some common used Sinks Blocks:

[ Scope

= Graph

Here are some common used Sources Blocks:

Step

oooo .
o0 Signal Generator

Tutorial: Introduction to Simulink



Start using Simulink

5
_/ Ramp
N R andom Nurmber
1 Cotistant

In addition there are lots of block in different Toolboxes:

+- ¥ Additional Math & Discrete
Zontro e Toolbox
| Data Acquisition Toolbo:
+-- W Fuzzy Logic Teolbox
B Model Predictive Control Toolbox
W NI SIT Blocks
+- W] Meural Metwork Toolbox
+-- T Real-Time Warkshop
+-- Wl Simulink Control Design
+-- Wl Sirulink Extras
+ EJ Simulink, Response Optimization
B Stateflow
+-- Bl System Identification Toolbox
+-- gl wirtual Reality Toolbox

2.2 Create a new Model

Click the New icon on the Toolbar in order to create a new Simulink model:

i1 Simulink Library Browser
File Edit Yiew Help

w_[;]ﬁ|

regzion for zeroz, Wector expressior
. or one if zeros iz a vecthor,

Create a new madel

The following window appears:

Tutorial: Introduction to Simulink



6 Start using Simulink

=1 untitled g@
File Edit Wiew Simulation Format Tools Help
=== 0.0 |Momal  >|| 55§
JReady 100% ode45

You may now drag the blocks you want to use from the Simulink Library Browser to the model
surface (or right-click on a block and select “Add to...”).

Example:

In this example we place (drag and drop) to blocks, a Sine Wave and a Scope, on the model surface:

E! untitled * |Z| |E| [z|
File Edit Miew Simulation Format Tools  Help
0 =EHE L 2 |'|EI.EI |N|:urmal j
r ] 1]
W
Sine Wave Scope
Ready 100%: oded5

2.3 Wiring techniques

Use the mouse to wire the inputs and outputs of the different blocks. Inputs are located on the left
side of the blocks, while outputs are located on the right side of the blocks.

Tutorial: Introduction to Simulink



7 Start using Simulink
.1
Inputs d vz P
. Integratord
"% Output
Caonstantd

When holding the mouse over an input or an output the mouse changes to the following symbol.

‘k_

Use the mouse, while holding the left button down, to drag wires from the input to the output.

Automatic Block Connection:

Another wiring technique is to select the source block, then hold down the Ctrl key while left-clicking

on the destination block.

Try the different techniques on the example above.

Connection from a wire to another block

If wire a connection from a wire to another block, like the example below, you need to hold down

the Ctrl key while left-clicking on the wire and then to the input of the desired block.

[ ]
g
W
Sine Wave Scope
]
Scope

2.4 Help window

)

¥

Sine Wave

—

Scope

Scoped

In order to see detailed information about the different blocks, use the built-in Help system.

Tutorial: Introduction to Simulink



8 Start using Simulink

=] Function Block Parameters: Integrator

Integrator

Continuoug-time integration of the input gsignal.

Parameters
E sternal reset; |r'u:|ne w |
|nitial condition zource; |internal w |

| nitial conditian:

0 |
[ Limit autput

|lpper zaturation limit:

lirk |
Lowser gaturation limit;

|- |

[] Show zaturation port
[] Show state port

Absolute tolerance:

|aut|:|

] lgnare limit and reset when linearizing
Enable zero crozsing detection

State Mame: [e.g., 'position]

F, H Cancel ﬂ Help ) Apply

All standard blocks in Simulink have detailed Help. Click the Help button in the Block Parameter
window for the specific block in order to get detailed help for that block.

The Help Window then appears with detailed information about the selected block:
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9 Start using Simulink

File Edit MVew Go Favortes Deshbop  Window  Helk L
| Help Navigator X imep TS| 04
Search for; | ¢ Lo | THe: Integrator o Blacks Sirolink) -
Exzmpbe "plot todls" OF ploc? took -~
Corrents | Indes: | Search Resuts | Demos Simulink [« 3
E-@ Sirnulink || Integrator i
i @ Getiing Started Integrate sigral
g Examples -
& % How Sirulink \Works L“"ary
&- B Simulink Basics e
# B Creating = Madsl
G—E Wiatking with Blocke Desc"pﬂon
& B Warking with Signals
!t--E Using Composite Signals ¥
- IF Wiorking with Dsta
L‘r--@ Warking with Lookup Takles The Integrator block outputs the infegral of its input at the current time step. The follovang squation
-8 Modeling with Simulink represents the output of the block y as a function of its mput w and an imtizl condition so, where ¢ and o
i @ Explonng, Sestching, and Browsing Mad ata yactor functions of the current simulation time .
#-I§ Running Simulations i
% E Analyzing Sirmulation Resulis ¥ = J urr}a"x+y5
#-B) Creating Slock Masks i
% B Sirnulink Debugger —| | Simulink can uze a number of different numerical integration methods to compute the Integrator block's
& % Sirnulink Accelarstor output, each with advaniages in particulsr applications. The Solver pane of the Configuration
& B Customizing the Simulink User Interdscs parameters dislog box (sec The Solver Pane) allows you to zelect the techrigue best guited 10 your
-3 Using the Embedded MATLAE Function application.
& % FrintFrame Editor Simulink treats the Integrator block a= & dynamic systern with one state, it= ouiput. The Integrstor

block's input is the state’s time derhative.

-~ Commonly Lsed

Continuous =Y
- Discontinuities B ]
Discrete = nld
-~Logic and Bit Operstions
Lookup Tahles The curently selecied soker computes the output of the Intearstor block st the current time step, using
- Matt Dperations w| | the curent inout value and the value of the stats at the prewous time step. To suppott this computational
< 1l | > model, the Infegrator block saves its output at the current fime step for use by the solver fo compute its o

2.5 Configuration

There are lots of parameters you may want to configure regarding your simulation. Select
“Configuration Parameters...” in the Simulation menu.

e Edit “iew mm Format Tools Help

I | Eé Skark Chrl4+T

|

Configuration Parameters.., Ckr+E

v Mormal
External

The following window appears:
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10 Start using Simulink

%% Configuration Parameters: Example2/Configuration (Active)

Select: ! Sirnulation time:
- Solver [ ST
Start time: | Stop time: | 10.0
- Data lmpart/E xport Im i— -| B s |
D!:tlmlzat.lon Solver optiohs
| [=-Diagnostics

- Sample Time Tupe: [Wariable-step w |Solver ode45 [Domand-Prince] ~|
- Data Validity ) Fan step size: |auto |Relative tolerance: 123 |
- Tupe Eo_m.fersmn Iin step size: {auko |Absolute toleramce: |auto |
- Connechivity e ; i:-:: AR e
- Compatibility Initial step- size: |auta
- Model Feferencing Zera crossing contral: !_L!§§_I99§_I_E§t_tir]gs Ji.]

~Hardware Implementatlon [ swstomatically handle data ranzfers betwesn tasks

- bodel Referencing

[=I-Real-Time Warkshap Solver diagnostic contrals
- Comments . ’ o cF ;
S b Mumber of congecutive min step size violations allowed: |1
- Custorn Code Consecutive zero crossings relative tolerance: u@?s“eps
- Debug Mumber of consecutive zero crossings allowed: |-'I--U-UU
- Interface
0K ] [ Cancel ] [ Help ] Lipply

Here you set important parameters such as:

e Start and Stop time for the simulation
e What kind of Solver to be used (ode45, ode23 etc.)
e Fixed-step/Variable-step

Note! Each of the controls on the Configuration Parameters dialog box corresponds to a
configuration parameter that you can set via the “sim” and “simset” commands. You will learn more
about these commands later.

Solvers are numerical integration algorithms that compute the system dynamics over time using
information contained in the model. Simulink provides solvers to support the simulation of a broad
range of systems, including continuous-time (analog), discrete-time (digital), hybrid (mixed-signal),
and multirate systems of any size.

2.6 Examples

Below we will go through some examples in order to illustrate how to create block diagrams and
related functionality.

Example: Integrator with initial value

Create the following model (an integrator) and run the simulation:

Tutorial: Introduction to Simulink



11 Start using Simulink

=] Integrator |Z| |E| fg|
File Edit ‘iew Simulation Format  Tools  Help
== = L] 2 |1EI.D |N|:|rmal ﬂ

L 2l
. w1
1 Integratar Scoped
Constant
Ready 100%: oded5

Stepl: Place the blocks on the model surface

This example use the following blocks:

1
z Integrator
1 Constant
[ Scope

Step 2: Configuration

1
z [rtegratar

Double-click on the Integrator block. The Parameter window for the Integrator block appears:

Tutorial: Introduction to Simulink



12 Start using Simulink

IZ] Function Block Parameters: Integrator

Inb=oraton

Continuous-tme integration of the input signal.
Pzarameters

Estemal ieset: [none v

Inkial condition source |2

[ Limit output

Upper zaturation limit:

|i| 1l |
Laower saturation limit:

[-inf |
[] Show saturation port

[ Show state port

Abzolute tolerance:

|aut0

[ Ignore limit and resst when linsarizing
Enable zero croszing detection
Sitate Name: [e.g., 'position’]

| 0K H Cancel ” Help ][ Apply ]

Select “Initial condition source=external”. The Integrator block now looks like this:

|.l'l|—'l-

1 Constant

Double-click on the Constant block. The Parameter window for the Constant block appears:

E! Source Block Parameters: Constant

Congtant

Output the constant specified by the 'Constant value' parameter. [F 'Constant value' iz
a vectar and Interpret vector parameters az 1-0° iz an, treat the constant value az a
1-0 array. Othenwize, autput a matrix with the zame dimenzions as the constant
value.

GETY | Signal Data Types

'ﬁ;s_tant vaILE\
/ |

|nterpret vector parameters az 1-D

—

Sampling mode; |Sample bazed |

Sample time:
lif |

ak. H Cancel “ Help ]

Tutorial: Introduction to Simulink



13 Start using Simulink

In the Constant value field we type in the initial value for the integrator, e.g., type the value 1.

Step 3: Wiring

Use the mouse to wire the inputs and outputs of the different blocks.

"% Output

Caonstantd

Inputs :‘.‘E %1; 2

Integratard

When holding the mouse over an input or an output the mouse change to the following symbol.

Draw a wire between the output on the Constant block to the lower input in the Integrator block, like
this:

1
— __|.|=).9ﬁ:.5
J Integratar

ke

1

Constanti

You could also do like this:

J Automatic Block Connection Tip E][E|Pg|

To quickly connect blocks, select the source block(z]. then hold
down the Chl ke while [eft-clicking on the destination block.

|:| Do not show this message again

Helgp ] [ Close

Wire the rest of the blocks together and you will get the following diagram:

Tutorial: Introduction to Simulink



14 Start using Simulink

1 ]
s I
Integrater
1 g Seaped

Constant

Step 4: Simulation

Start the simulation by clicking the “Start Simulation” icon in the Toolbar:

Step 5: The Results

Double-click in the Scope block in order to see the simulated result:

(=63

Time offzet;

Tutorial: Introduction to Simulink



15 Start using Simulink

Example: Sine Wave

Create the block diagram as shown below:

= Example

File Edit Wiew Simulation Formak  Tools  Help

=== =2 3 10.0

1
iy I N
WS £
Sine Miave Integratar Scope
Ready 100%: oded5

Set the following parameter for the Integrator block:

IZ] Function Block Parameters: Integrator rg
Integrator
Continuous-time integration of the input signal.

Parameters

Iritial condition sourcs: intemal v|

| 1 j |

[ Lirnit output

Upper saturation limit:

[inf |
Lower zaturation limit:

[ |

] Shiow saturation part
] Shiow state port

Abgolute tolerance:

|aut0

] Ignore limit and reset when linearizing
Enable zera crozsing detection
State Mame: [2.g., ‘position’)

kK H Cancel ” Help Apply

The result should be like this:

Tutorial: Introduction to Simulink



16 Start using Simulink

Time offset: 0O

Example: Using vectors

Create the following block diagram:

1
am o 1 >|K_ . [
Sine M'ave Integratar Zain Saturation Seope

For the Gain block, type the following parameters:

Tutorial: Introduction to Simulink



17 Start using Simulink

E! Function Block Parameters: Gain

EET

Element-wize gain [y = K. %] or matris gain [» = £ or y = K]

[ ET | Signal Data Types Parameter Data Types

L Ta ain:
AR |

Multiplication: |EIement-wise[K.“u] w |

Sample time [-1 for inherited]:
i |

] ] [ Cancel ] [ Help Apply

As you see, we can use standard MATLAB syntax to create a vector.

If you want to see the signal dimensions, select “Signal Dimensions” and “Wide Nonscalar Lines” as
shown here:

kion Tools  Help

. B2 Font... |1 0o |N|:urmal ﬂ
Flip Name
Flip Block, Chrl+I
Rokake Block, Ckrl+R,

T | Hide Mame u

Q{ Show Drop Shadov >

—_— u

QR n Saturation
Foreground Colar »
Background Colar »
Screen Color »
Port/Signal Displays Sample Time Colors
Block, Displays ¥ | v Linearization Indicators
Library Link Display » Port Daka Types

C_Signal Dimensions

Starage Class
100% w Testpoint Indicators
v Wigwer Indicators

Wide Monscalar Lines
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18

Start using Simulink

The block diagram should now look like this:

e

-'r"lU -'1_ ’[EEK i 8

Sine Wiave Integrater zajn Saturation

Sgope

\

The thick lines indicate vectors, while the number (8) is the size of the vector.

Let’s change the Saturation block:

E! Function Block Parameters: Saturation

S aturation

Lirnit input zignal to the upper and lower zaturation values.

Farameters

U~

rand(3110 N\

Lowver limit;

and815-10  /

\Tm"’w when linearizing

Enable zero crozsing detection

Sample time [-1 for inkernted]:

-1

] H Cancel ][ Help

Apply

As you see you may use standard MATLAB functions and syntax.

Run the simulation and see the results in the Scope block.

Tutorial: Introduction to Simulink



3Useful Features

You should know about these features in Simulink in order to take full advantage of Simulink.

3.1 Comments/Labels

Double-click on your surface in order to write Labels or Comments in your model block diagram.

Thiz is a label Thiz is alzo a label

nn b i /",I:I

Fulse // Fulse Scope

Generatar k
Double-click to create labels Change default
Block labels

3.2 Align and Distribute Blocks

You may align your blocks:

19
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Useful Features

]
Integrator

'(\ o i ?—:sﬂ‘ 1
L Cut
ne Wave Gain. S?t?ra
Copy
Delete
Gonnett Blocks
Create Subsystem

Looklinder Mask

Requirements »

Scope

& Blocks >

3.3 Flip Blocks

Align Top Edges
align Centers Horizontally
Align Bottom Edge;

Normally the inputs are on the left and the outputs on the right, but in some cases it is convenient to

have the inputs on the right and output on the left side.

1L 1
z _u 4 3

Integratort Integrator

In order to “flip” the input and outputs right-click on the block and select “Flip Block”.

Tutorial: Introduction to Simulink



21 Useful Features

| =

Intzqn Explore

Cuk

Copy
Delete

Integrator Parameters. ..
Block Properties. ..

Linearize Block. ..

Signal & Scope Manager. ..

Part Signal Properties 4

Flip Mame
Background Calar r Hide Mame
Flip Block, Chrl+1

Help Rotate Block Chrl+R

Show Drop Shadow

3.4 Hide Names

Hide default labels that appear on the diagram, such as Constant1, Integratorl, etc.

Select “Hide Names” on the “Format” menu:

Tutorial: Introduction to Simulink



Useful Features

& Simulation

& & B

itep

Tools  Help

Font..,
Text alignment
Enable Tex Commands

Flip Marne
Flip Block.
Rotate Block

Foreground Color
Backqground Color
Screen Color

PartfSignal Displays
Black Displays
Library Link Display

Chrl+I
ChrHR

100 |Homal

] .
il ==

*

o

Constantt

=

Froductd

!

a2

Constant

-
L
b fProdud

®ole
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4Data-driven Modelling

You may use Simulink together with MATLAB in order to specify data and parameters to your
Simulink model. You may specify commands in the MATLAB Command Window or as commands in
an m-file. This is called data-driven modeling.

4.1 Command window

Example:
1 3 3
ﬁu e - ’\K' - =
Sine Wrave Integrator Fain Saturation

p— [l :
Zero-Order Scope
Hald

S

Zero-Order
Hald4

YvY
]

Note! In order to get 3 inputs on the Scope block:

Double-click on the Scope and select the Parameters icon in the Toolbar:

Parameters

Then select Number of Axes=3:

23
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Data-driven Modelling

-} 'Scope’ parameters

Genetal || Data history | Tigx: try right clicking on axes

Mumber of axes: |§

flosting scope

Titve range: |aut.:.

Tick lakels: |t:u:¢t|:|m axis only vi

Sampling

|Dec:ima‘tin:nn “ | :1 |

[ o | (o] [0 | (oo |

Configure the zero-order hold blocks like this:

3] Function Block Parameters: Zero-Order Hold

Zero-Order Hold

Zero-order hold.
Parameters

Sample time [-1 for inherited):

(] ” Cancel ][ Help Apply

Zern-Order Hold

Zero-order hold.
Parameters

Sample time [-1 for inherited):

0k H Cancel ” Help Apply

Write the following in the Command window in MATLAB:

Tutorial: Introduction to Simulink



25

Data-driven Modelling

[Command Window

o To get started, select MATLAE Help or Demos From the Help menu.

=0 ® X

X

> Tsl=0.2

T=1l =

0.2000

> TsZ=0.5

Tsz =

0.5000

p

Run the Simulink model from the Simulink:

§2|_UIWI
Wy

We then get the following results:

Tutorial: Introduction to Simulink



26 Data-driven Modelling

Time

4.2 m-file

It is good practice to build your in Simulink and configure and run the simulation from a MATLAB
m-file.

A Typical m-file could look like this:

Tutorial: Introduction to Simulink



27 Data-driven Modelling

& Editor - M:\Work\Training\MATLABAn Introduction to Simulink\Code\Mass-Spring-Dam...
File Edit Text Go Cell Tools Debug Deskbop Window Help

DEH|imBo o8 Mess B0 ARNEA| |

o |"BiE ]| -[to [+ ] #[11 |x |42 | @,
1 38eript of mass-spring-damper simulator. =
2 YHans—-Petter Halvorsen. 20.11.2009
3
4 2Modell Parameters
5= ¥ _init=4; 3[m]. Initisl position.
6 — dudt_init=0; Y[mfs] . Initial Spesd.
7T — w=el; %[kal
8 — c=4; [N/ im/s)]
9= k=2: %[MN/m]
10 — £_step F=50; %[s]
1l — F_C=0; %[H]
RIS Fol=2: %[H]
13
14 Y3imulator Settings
15 — t_stop=100; %[s3]
16 — T_s=t_stop/1000; %[s]
17 = optionz=zimset|'solver', 'odeS', 'fixedstep', T_=):
18
19 YEtarting simulation
20 — Simi'mass_spring damper', t_stop, options):

['seript I = -

You use the simset command to configure your simulation parameters and the sim command to run
the simulation.

The variables you refer to in the m-file is set in the Constant value field in the Parameter window for
each block.

E! Source Block Parameters: Constant1

Congtant

Output the constant specified by the 'Constant value' parameter. I Constant value' is
a vectar and Interpret vector parameters az 1-0° iz on, treat the constant value az a
1-Dv array. Othensize, output a matrix with the same dimensions az the constant
value.

b air Signal Data Types
onstant walue: \.l
|nterpret wector parameters as 1-0

Sampling mode: |Sample bazed |

—

Sample time;
i |

[ ] H Cancel ][ Help ]

4.3 Simulation Commands
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28 Data-driven Modelling

The most used command is:

e simset
e sim
Use these commands if you configure and run your Simulink model from a m-file.
Example:
$Simulator Settings
t stop=100; %[s]
T s=t stop/1000; %[s]

options=simset('solver', 'ode5', 'fixedstep', T s);

$Starting simulation
sim('mass spring damper', t stop, options);
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5Hybrid Systems
(continuous and discrete)

You may mix continuous blocks and discrete blocks in the same system, so-called Hybrid systems.

Example: Hybrid System

Create the following block diagram:

ﬁ\f =1;4>~K- ] » R

Sine Miawe Integratar Fain Saturation
g
» > Ll
I +
Zero-Order Scope
Hald
Zero-Order
Hald1
3tion Tools  Help
% @ ot | I'IEI.EI INu:nrmaI ;I
— 1  Text alignment 3
Enable Tek Commands
Flip Mame
Flip Block, Chrl+I
Ruokake Block Ckrl+R,
7 WL
Shiow Marne v/ i
Show Drop Shadow ne Wl awe Integratar
Show Port Labels 3
Foreground Colar 3
Background Colar 3
Screen Color k
Port/Signal Displaws
Block. Displays
Library Link Display r Port Diata Types

v Signal Dimensions

Sharane Mlacze

The Block diagram now looks like this:
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Hybrid Systems (continuous and discrete)

30
1 3 3
ﬁu .‘ ; ’\K' I= i
Sine WMrave Integrator zain Saturation

— [

) [ 2

¥

|

Zero-Order
Hald

Zera-COrder
HoldA

Scope

The black color is the continuous system while the colored part (red and green) is the discrete part of

the system.
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6Example:
Mass-Spring-Damper
System

6.1 Model

In this example we will create a mass-spring-damper model in Simulink and configure and run the
simulation from a MATLAB m-file.

In this exercise you will construct a simulation diagram that represents the behavior of a dynamic
system. You will simulate a spring-mass damper system.

F(t) — cx(t) — kx(t) = m¥(t)

where t is the simulation time, F(t) is an external force applied to the system, c is the damping
constant of the spring, k is the stiffness of the spring, m is a mass, and x(t) is the position of the mass.
X is the first derivative of the position, which equals the velocity of the mass. X is the second
derivative of the position, which equals the acceleration of the mass.

The following figure shows this dynamic system.

Fitl
+_

| xn

The goal is to view the position x(t) of the mass m with respect to time t. You can calculate the
position by integrating the velocity of the mass. You can calculate the velocity by integrating the
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32 Example: Mass-Spring-Damper System

acceleration of the mass. If you know the force and mass, you can calculate this acceleration by using
Newton's Second Law of Motion, given by the following equation:

Force = Mass x Acceleration
Therefore,
Acceleration = Force / Mass

Substituting terms from the differential equation above yields the following equation:

1
¢ (F—ct—k
X ( cx — kx)

You will construct a simulation diagram that iterates the following steps over a period of time.

6.2 Simulink

Create the block diagram for the mass-spring-damper model above.

Instead of hard-coding the model parameters in the blocks you should refer to them as variables set
in an m-file.

E! Source Block Parameters: Constant

Conztant

Output the constant zpecified by the 'Constant walue' parameter. If 'Constant valug' is
a wector and Interpret wector parameters az 1-D'is on, treat the constant value az a
1-D array. Othenwise, output & matrix with the zame dimenzions as the conztant

walle.
Mz ighal D'ata Types
Conztant valua
(e ) |
Fverpret vector parameters as 1-0

Sampling mu:u:le:|5ample bazed |

Sample time:
lirf |

0k H Cancel H Help ]

These variables should be configured:

e X init
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33 Example: Mass-Spring-Damper System

e dxdt_init
® m=

e (=

o k

o t step F
e FO

e F 1

6.3 m-File

The following variables should then be set in the m-file:
X init=4; %[m]. Initial position.
dxdt init=0; %[m/s]. Initial Speed.

m=20; %[kg]
c=4; %

6.4 Results

The Block Diagram should look something like this:

= mass_spring_damper

File Edit ¥iew Simulation Format Tools Help
0= ES w2 3 10.0 Marmal | O e B EE®
Y |
F ’ I |§|
U=
> 1 *
Yoz
JReady 100% T=0.00 odeds
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34 Example: Mass-Spring-Damper System

The m-File should look something like this:

& Editor - M:\WorkYTraining\MATLABMAn Introduction to SimulinkYCode\Mass-Spring-Dam... D@

Fil=  Edit Text Go Cell Tools Cebug Deskiop  Window Help WA M
lH iRy« |5 henf | 8R0RAREEA = ] [O¥
2 (BB 2| - [0 [+ | +[11 [x |o et | @
1 (5eript of mass-spring-dawper simulator. =
2 Y¥Hans-Petter Halvorsen. 20.11.200%9
3
4 (Modell Parsmeters
5= ¥ _init=4; %[m]. Initial positilon.
6 — dudt init=0; ¥[m/2] . Initial Speed.
T — w=20; %[kg]
83— c=4; 5[N/(m/s)]
9. = k=2: 5[N/m]
10— £ _step F=50: %[=3]
11 — F 0=0; 3[HN]
la= F_1=4; 5[N]
13
14 Y3 imulator Settings
15 — t stop=100; 35[=]
16 — T ==t _stop/1000; %[=]
b options=simset|'solver', 'odes', 'fixedstep', T_3):
1a
19 ¥3tarting sSimulation
20 — Sim('wass_spring dswper', t_stop, options);
seripk lLm 16 Caol 22

Graphs:

Force F

PP ABE B &

30

Position x and speed x:

100
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Example: Mass-Spring-Damper System

Time offset: 0O

B[=1E

a0 100
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/Embedded Algorithms

This chapter explains how you incorporate an existing MATLAB function into your Simulink model.

Make sure your MATLAB function is compiled as an embedded MATLAB function using the #eml|

directive, e.g.:

E Editor - C:\IntroSL\Sampling_error.m

File Edit Text Go Cell Tools Debug Desktop Window Help

DEHEH| Q9206 | Aea k-

D[BBE[-Fo_+|«f_ x[#A&£[O

1

D s N

Jfunction y = Sampling error(ul,u2)

wveights = 1./(3:1:10];

S1 = {ul.*weights')'*ul;
82 = (u2.*weights')'*u2;

g = 81 - 52;
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37 Embedded Algorithms

=1 simulink Library Browser
File Edit Wew Help

O Ha b |
Embedded MATLAB Function: Embedded MATLAR block

= Nl Simulink, -
%] Commorly Used Elacks TN SRR | E rrbedde=d
m Continuous
# Discontinuities L)) Fcn
g Discrete
g Logic and Bit Operations mifile Lewvel-2 -file S-Function
1 Lookup Tables
% Math Operations MATLAE Fon
1 Model Verification Function

1 Model-wide Utilities

system S-Function
% Parts & Subsystems

DI

g Signal Attributes

H Signal Routing = ayzkem S-Function Builder
2| Sinks _

& sources SEi::::an 5-Furction Examples

%] User-Defined Functions
+ 2| Additional Math & Discrete
B Control System Toolbox
B Data Acquisition Toolbo:
+-- N Fuzzy Logic Toolbax
Ready

5

Drag in the Embedded MATLAB function:

1 8 2 8
[Tl P

Sine Wave Intagrator Gain Saturation

! [ apll] g fen wp

Zero-Qrder
Hoid

]
Sespn Embedded

MATLAB Function

Double-click on the Embedded MATLAB function give us the standard template for an embedded
function:
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38 Embedded Algorithms

3 Embedded MATLAB Editor - Block: Intro_SL /Embedded MATLAB Function

e ERt Text Debug Took Window Heb ‘
D E| B2 A0+ |S&E|»=" 88

1 funcrion ¢ = fen(u)

2 ¥ Thisz block supports the Embedded MATLAER =zubser,
3 % 3ee the help menu for details.
4
S =

¥ =W I

Modify the template so it calls your MATLAB function:

Embedded MATLAB Editor - Block: Intro_SL/Embedded MATLAB Function

File Edt Text Debug Tools Window Help

> £

functicon y = fcn(ul,uzb
% This block supports the Enbedded MATLAE subset.
% See the help menu for detaills.

bW N -

-~ § = Sampling error(ul,u):;

Wire the system like this:

A =%_®8 > 3 L
3 2

Sine Wave Integrator Galn Saturation
ol
= [ i ] ten ,DI
S 1

g o {u2
Zero-Didas Scope
Hold Embeddad
MATLAB Fundtion

L

Zeto-Oedar
Hold!

Run the Simulation:
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Embedded Algorithms

-loix
SEP PP ABEIDAE F -
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8Subsystems

You create subsystems to create hierarchical systems and hide details in the model.

Select the part of your system from which you want to create a subsystem, right-click and select
“Create Subsystem”.

1

a) N

Sine Wave integeator

Example:

ﬁ\} » 1 44% >

Sine Wawve Integratar ain Saturation

¥

I

ero-Crder Scope
Haold

Ly J_LI_
Ll
Zero-Order
Huold1

LAdd

I

Right-click and select “Create Subsystem”:
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Subsystems

Ot 1
&) 1 <
U I - = Ini1 Ot g
Sine Miave Integratar Jut3 Scope
Subsystem

If we double-click on the subsystem we see the blocks in the subsystem:

Zain Saturation

O > '
I:Iut*l

— [ )

Zero-Crder Dutz
Hald
g
— |0 D
Zero-Order Duts
HaldA

Right-click on the block and select “Edit Mask” in order to open the Mask Editor:

Mask Editor : Subsystem

aramekers | Initializakion | Docurmentation

Icon aptions Drrawing carmnands

Frame

Visible:

I

Transparency

Opaque w

fa)
=]
=3
m
o
=}
juu }

Fixed v

Units

Aukoscale w

Examples of drawing commands

Carnmand | port_label (label specific ports) v|

Synkax  pork_label{'output’, 1, ')

[ a4 ][ Cancel ” Help ” Apply l
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42 Subsystems

The Mask Editor allows you to change how the subsystem should look, e.g., the subsystem icon.

.’4
—»f T apll]
P
Integrator ; Scope
Subsystem
£
E4Mask Editor : Subsystem <
Icon | parameters | Inkialization | Documentation |

~Icon options—— -Drawing commands

Frame plot (peaks)

| visible |

Transparency

[opaque ]

Set Parameters for the subsystem:
E¥ Mask Editor : Subsystem A is = |D|_!
Icon Parameters | Initialization | Documentation |
- Dialog parameters
Prompt Variable Type Evaluate | Tunable
Sample Time 1 Ts1 edit - v v
Sample Time 2 Ts2 edit | v v

Jo [ [ |

Double click on the sub system now gives the Parameter window for the subsystem:
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Subsystems

A

[ - Pacameters

1
» e

Sine Wave

<

Integrator

Subsystem

L} Function Block Parameters: Subsystem

~ This it my custom subsystem (mask)
This subsystem samples the signal ot 3 specified rate

Sample Time 1

T
Sample Tine 2

{0
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9Model Explorer

The Model Explorer allows you to quickly locate, view, and change elements of a Simulink model or
Stateflow chart.

To display the Model Explorer, select Model Explorer from the Simulink View menu.

P Madel Explorer

Fie Edt Wisw Tools Add  Help
D dRBX B ERE[]7 Fod oOnd
Search by Name | Mlarne: @ Search
Model Hisrarchy [ Contents of: Taskl_ 5/Subaysternd | Function Elock Parameters: Subsystem]
12 95 mudink Ficat : = Sksyten
BB ase Wokspacs Rame: Hlnchkiors)ie Select e sstiings for e sLbsystem Hock.
= Task1 5 I Coristark2 shant
b B Mosel Woikspace = Irtegratont Tl )
- B Conliguralion [ciivel L1 Pioduct2 Shaws pott [amels FromPerilcan |
il : = -
i @C"d‘ b Tkl o = Fead iile Ceqmissiong Readite l
G dvice for Taski_5 L] ikl il
1 ot Mame ol errar calback function
ISy [ ]
Frmit hiersrchical resobice: |4l |
[] Trzat as aboriic urit
L i
Corients | Saarch Fesuks | s Appy
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10 Exercises

In this chapter we provide more exercises.

Exercise:

Build the following block diagram:

Gravity elaciy el » ]
Position iti
a8 > Position >
Fozition
o 1
-*'S Velocitr S_/-
13
o BE
Iz
Fosition
0.8
Elasticity

In this exercise we will model a rubber ball that is thrown in the air with an initial velocity of 15 m/s
from a height of 10 m. We will model the dynamics of the ball as it bounces, under the influence of
gravity. We will assume that 20% of the energy is lost on each bounce. (That is, after each impact, the
ball will travel at 80% of its prior velocity, but in the opposite direction.)

We can model this example by integrating g (g = -9.81m/s”2) over time with the initial condition set
to 15 m/s. We reset the integrator each time the position reaches zero meters and set the new initial
condition to -80% of the impact velocity. Position is modeled by integrating the velocity over time
with the initial condition set to 10m/s.

The result should be:

Welocity

10

Position
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46 Subsystems

Watch this video to see the result:
http://www.mathworks.com/products/demos/simulink/Simulink Key Features/videos/building.h

tml
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